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1. Overview 
 
SwitchCenter software is a JAVA based desktop application which allows the control and monitoring of a 
switching system.  It is compatible with switch models R1000, R5000, R6000, and D1000.  With 
SwitchCenter you can: 
 

* control switches at the card, rack, and system levels 
* monitor system health status; power supplies, key switch position 
* display event traps from one or more systems 
* monitor IP addresses and switch in response to communication loss 
* set scheduled one time or repeating switching actions 

 
After setting suitable parameters for a given site (system), these parameters can be saved to a file for later 
retrieval.  In this way, any number of systems can be controlled by a single instance of the program, 
however only directly accessing one system at a time.  SwitchCenter also supports a restricted mode, 
which allows only monitoring activities without an administrator password. 
 
 
2. Installation 
 
SwitchCenter software requires a computer running the Java Standard Edition (Java SE).  At the time of 
this SwitchCenter release, the current version of Java SE is Java SE 6 Update 10.  SwitchCenter should 
operate with later versions of Java SE, and may operate with some earlier versions as well.  
 
To install Java SE go to the Sun website http://java.sun.com/javase/index.jsp and follow the "Java SE" 
link under Downloads. On the download page you need to download the Java Runtime Environment 
(JRE) for the appropriate operating system. Follow the Sun provided Installation Instructions to complete 
Java SE installation on your system. 
 
After successfully downloading and installing the Java SE package, you will need to download and setup 
the SwitchCenter application.  
 
The SwitchCenter Application is delivered as a single JAVA ARchive (JAR) file which you can 
download from website www.secureswitch.com (click on the "Documentation" radio button, and then 
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click on the "SwitchCenter Graphical User Interface Download" link located under the "SwitchMaster" 
section of products). Use the Save As feature of your browser to download the file. 
Verify that the name and extension of the file is mcsc1_9.jar, (Note: If the file has a .zip extension, you 
must change it to .jar prior to saving).  Browse to "C:\Program Files\Java\jre6\bin, and click Save.  This is 
to save the file in the same folder as the javaw.exe file. 
 
Once the .jar file is downloaded, you can then start SwitchCenter in the following ways:  
 
1.  You can create a DOS batch file containing the command line 
"C:\Program Files\Java\jre6\bin\javaw.exe" -cp mcsc1_9.jar switchcenter.Application   (Note: The double 
quotes are required and switchcenter.Application is case sensitive.)  The batch file must be located in the 
same folder as the “javaw.exe” and “mcsc1_9.jar” files. 
 
You will need to modify the batch file command line if the location of your Java runtime files are not at 
the default location, or if you are using a later version of JRE, or if you have downloaded a later version 
of the SwitchCenter application (the current version is mcsc1_9.jar at the time this document was 
generated). If necessary, change the path "C:\Program Files\Java\jre6\bin" to the location that your Java 
runtime files are located, and change the SwitchCenter .jar filename. Once you have created the batch file, 
you can open a DOS command prompt, navigate to the directory where the batch file and the 
SwitchCenter .jar file are located, and then type the name of the batch file at the command prompt. 
 
If operating in a Windows environment, you can also run the batch file from the taskbar. Select start -> 
Run... and enter the path and name of the batch file. 
 
2.  You can create a shortcut to run the SwitchCenter application. 
 
Be sure to set the working directory (the "Start in:" location) to the directory of the SwitchCenter .jar file.  
Start in: “C\Program Files\Java\jre6\bin” 
 
Also be sure to set the “Program:” or "Target:" as follows: 
Target: “C\Program Files\Java\jre6\bin\javaw.exe” –cp mcsc1_9.jar switchcenter.Application 
 
(Note: The double quotes are required and switchcenter.Application is case sensitive.) 
 
You may also want to select the run minimized option to hide the Command window that launches the 
application.  
 
Again, if necessary change the path "C:\Program Files\Java\jre6\bin" to the location that your Java 
runtime files are located, and change the SwitchCenter .jar filename. 
 
After the installation of SwitchCenter is complete, you should be able to run SwitchCenter and from the 
main Switch Control tab access the Site Settings window.  There you will enter the IP address or fully 
qualified domain name of your target R1000, R5000, R6000, or D1000 system, and SNMP read/write 
community names.  Once this is done you'll be able to access status, and control the switches in your 
system. 
 
Creating and Using a profile with SwitchCenter: 
 
To avoid having to re-enter your site settings information each time you start SwitchCenter, you can 
create a saved profile. To start SwitchCenter with a saved profile, you must first run SwitchCenter, create 
a profile, save it, and then add the saved profile filename to the command line that is used to launch 
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SwitchCenter. To do this, start up SwitchCenter. Once SwitchCenter is running configure it with the 
correct IP address and other settings appropriate for your site. After SwitchCenter is fully configured and 
working properly for your location, click on the "File" pulldown menu at the top of the SwitchCenter 
window and then select "Save As". In the Save As window that pops up, specify a filename and the 
location where you want to save the profile. Now that the profile is saved, you must then append this 
filename to the end of the command line that launches SwitchCenter. For example, if you saved your 
profile on the root directory of the c: drive as the filename "R6000profile", then change the command line 
that is used to launch SwitchCenter to: 
 
"C:\Program Files\Java\j2re1.4.2_01\bin\javaw.exe" -cp mcsc1_9.jar switchcenter.Application c:\R6000profile 
 
Once you have started SwitchCenter, you can click on "Help" and then "Contents" for a description of the 
available features and functions.  
 
 
Additional notes: 
 
If you use java.exe instead of javaw.exe to run the SwitchCenter software, you will receive multiple 
exception messages when SwitchCenter first starts up. The messages "rx Exception: 
java.net.SocketTimeoutException: Receive timed out" are displayed and then the PASSWORD window 
opens. These exception messages are simply status messages that are being generated while SwitchCenter 
attempts to establish a connection to the R1000, R5000, R6000, or D1000 switching system it is to 
monitor/control. Once SwitchCenter has successfully established a connection to the controller card in the 
R1000, R5000, R6000, or D1000 switching system, these status messages will stop. Running javaw.exe 
suppresses these exception messages. 
 
Also, if you start SwitchCenter using java.exe and you don't specify a saved profile when starting 
SwitchCenter, you will get even more of these exception messages when SwitchCenter starts up. This is 
because SwitchCenter repeatedly tries to use the default IP address of 192.168.1.30 to connect to the 
R1000, R5000, R6000 or D1000 switching system. Until SwitchCenter is configured with the correct IP 
address of the switching system it is to monitor/control, each time it tries to make a connection using the 
wrong IP address, an exception status message will be generated. 
 
To start SwitchCenter with a saved profile, you must first run SwitchCenter, create a profile, save it, and 
then add the saved profile filename to the command line that is used to launch SwitchCenter.  Refer to the 
section above for instructions about creating and using a profile with SwitchCenter. 
 
The following sections in this manual describe the features and capabilities of each tab in the main 
SwitchCenter window. 
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3. SwitchCenter Main Window 
 
This is the main application window presented when running SwitchCenter.  The top menu bar provides 
file access and help, while the body of the main window contains tabs for selecting among the various 
pages of control.  
 

 
Figure 1 - SwitchCenter Main Application Window 

 
Select from the File drop-down menu list to Save or Open a SwitchCenter configuration profile file.  This 
file will contain all the site setup parameters, as well as IP monitor and scheduled event lists.  You can 
save multiple files to allow quick access to different systems, or differing access to a single system 
(different scheduled event lists for instance).  The current SwitchCenter profile name will be displayed in 
the main window title bar. 
 
SwitchCenter can be started with a command line filename for specifying site setting parameters.  In 
general it’s best to do this, otherwise SwitchCenter starts with default parameters and as they most likely 
won’t match your site settings, startup will be slower as the initial status information updates fail.  
 
Select "Contents" from the Help drop-down menu list to access the online help documentation, or see 
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information about the version of SwitchCenter in "About". 
 
To navigate between the pages of the main window, select the named tabs under the menu bar; Switch 
Control, Trap Display, IP Monitor, or Scheduled.   
 
4. Switch Control tab 
 
The Switch Control page is where all status and switching of the system is controlled.  First, the site 
information must be entered (at minimum IP address, read/write passwords and model). 
 
Quick Site Setup… 
 

Click the button labeled Site Settings…. 
Enter the IP address of the R1000, R5000, R6000, or D1000 switch system.  The default is 
192.168.1.30. 
Enter the SNMP read community name.  The default for the switch is “public”. 
Enter the SNMP write community name.  The default for the switch is “private”. 
Select the model from the drop-down list. 
Click OK and you are ready to go. 
(see the detailed Site Settings section for a description of advanced site settings). 

 
After changing the site settings, or loading from a saved file, the rack number will be set to 1.  This is the 
default first rack in a system, and the R1000, R5000, R6000, or D1000 rack with the SNMP port must be 
set to address 1.  When the rack number is changed, or there is no prior information, SwitchCenter will 
collect from the addressed system all of the appropriate information to populate the System and Rack 
Status frames, as well as update the switch control area (found at the lower section of the main window) 
including individual switch names if configured to do so (see Site Settings section for advanced site setup 
parameters). 
 
Note that some fields and SwitchCenter functions are supported only by the latest revision switch system 
software (as reported in the System and Rack Status frames).  Unsupported fields will be shown as no 
response or skipped when encountered.   
 
To change the addressed rack, enter a new number in the Rack Number field and press the keyboard Enter 
key.  Alternatively, change the Rack Number and click the button labeled Refresh Status. 
 
To refresh the information displayed in the System and Rack Status frames, click the button labeled 
Refresh Status.  To update the switch port control area, click the button labeled Update (if the switch 
names are already loaded they will not be re-loaded). 
 
The System Status area contains the latched generic and system traps.  Pausing the mouse pointer over 
either displays a decoded listing of the events corresponding to the displayed number.  These latched trap 
values collect traps that occur in the system.  Double-click either latched trap to clear that particular 
value.  This area also shows the SNMP handler software revision (from the switching system) and the IP 
Requestor variable (which is the IP address of the last entity to access the switch).  These values are read 
only. 
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The Rack Status area contains the following entries: 
 
Name This name is stored in the switching system’s non-volatile memory.  Double-click to 

change. 
Health This shows the status of each switch card in the rack.  A 1 indicates the card is present 

and healthy (communicating, no internal errors), and a 0 indicates the card is either not 
present or faulty in some manner.  Read only.  Note that this feature is supported by 
R6000 Switching Systems, it is not supported by the R1000, R5000, or D1000 Switching 
Systems. 

Key State The rack keylock switch status - either ON or OFF.  Must be ON to allow manual 
switching.  Has no affect for SNMP or SwitchCenter control.  Read only. 

Power Supply Shows the power supply status; two supplies, one supply down, external supply.  Read 
only. 

Software Rev Software revision level of the rack controller card firmware.  Read only. 
Groups This field allows cards within a rack to be controlled in groups where a single command 

will cause all cards in that group to switch together. Note that this feature is supported by 
R6000 Switching Systems, it is not supported by the R1000, R5000, or D1000 Switching 
System. The rack group setting string is a 16 character field with one character for each 
card (up to sixteen cards) in the rack.  Any character can be used to label a group except 0 
or upper case X. The 0 character is reserved to indicate that the associated card operates 
independently (is not in any group). Upper case X is used to skip a position - when editing 
an existing group string upper case X will leave that card’s group character unchanged 
from its previous setting.  All cards in a group follow any switching command to any card 
in the group, including manual switching.  Once switching has occurred, click on the 
Update button to display the new switch positions in the rack. Double-click in the Groups 
field area on the screen to change the Groups setting. Changes to the Groups settings are 
saved in the target Switching System's non-volatile memory to insure that cards within a 
group maintain their associations even if the connection to the SwitchCenter application is 
lost. The following example shows how the Groups settings can be used. Suppose that a 
switch rack has cards in slots 1 through 10 and 12 thru 16 (slot 11 empty). You could set 
the first 4 cards in one group, the next 6 in a second group, set the card in slot 12 to 
operate independently, and configure the last 3 cards to operate as a third group by double 
clicking in the Groups area and entering the string 1111222222e0333. In this example, 
any character could be used for slot 11 since it is an empty slot. 

 
 
5. Switch Port Control Area 
 
Below the System Status and Rack Status areas on the Switch Control tab display screen is the switch 
port control area. This area displays a button for each of 16 possible switch ports in the addressed rack, 
and shows the position as either A, B, or X (and grayed out) if the switch position is not populated in that 
rack.  The switch name is also displayed if the switch name feature is enabled.  To change (toggle) the 
state of an individual switch port, click that button once.  To set all the switch ports in the addressed rack 
to either A or B click the button labeled Set Rack A or Set Rack B respectively.  And to set all the switch 
ports in the addressed system to either A or B, click the button labeled Set Sys A or Set Sys B 
respectively.  To change the name of a switch port (the "use switch names" checkbox under the "Site 
Settings..." button, "Advanced" tab, must be selected for this feature to work), right-click the appropriate 
button and enter a new name in the box provided. The switch port names are stored in the switching 
system’s non-volatile memory. 
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For SwitchCenter to properly address the individual switch cards in a R5000 system, the switch cards 
must be numbered similar to a R6000 system.  The R5000 switch cards should be numbered sequentially 
with cards 1 through 16 in rack 1, cards 17 through 32 in rack 2 and so on.  In the “Site Settings…” page, 
“Advanced” tab, the “Skip status fields on timeout or error” is used to reduce time spent waiting for 
responses from racks or cards which are not present.  If the “Skip status fields on timeout or error” box is 
checked, and the R5000 cards are addressed 1, 2, 3, and 5, SwitchCenter will get a timeout when 
requesting information from card 4, and it will not request data from cards 5 through 16. 
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6. Trap Display tab 
 
The trap display page displays traps sent to this computer from one or more sources.  These sources can 
be one or more switching systems, or any other source of traps, if they are sent to the IP address of this 
machine. Note that the R1000, R5000, R6000, and D1000 support a number of specific traps that identify 
changes to the switching system’s status (refer to the documentation for your particular R1000, R5000, 
R6000, or D1000 switching system to see which MIB and SNMP variables are applicable to your 
product). 
 
To inhibit display of traps not originating from the addressed switching system, select the appropriate trap 
filter option from the "Site Settings..." radio button (click on Site Settings, then select the Advanced tab, 
then click on the appropriate check box). Some routers and other SNMP devices broadcast traps which 
will be received and displayed if not filtered. 
 

 
Figure 2 - Trap Display Window 

 
To clear the trap display, click the button labeled Clear.  To copy the event listing to the clipboard click 
the button labeled Copy. 
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You can also manage the SNMP manager settings within the switch system by clicking the button labeled 
SNMP Managers….  This will open a window allowing the editing of SNMP manager addresses 1 thru 
16 on the switching system.  Select an entry in the table, and select Edit… or Remove to change or clear 
an SNMP address entry.  When all changes are made, click Close. 
 

 

Figure 3 - SNMP Manager setup window 

 
Note that displayed trap events are not saved through the File Save operations. 



SwitchCenter Page 11 of 18 

7. IP Monitor tab 
 
The IP monitor page of SwitchCenter allows any IP address to be monitored for connectivity, and when 
that host fails to respond, a port can be disconnected (switched from B to A).  This feature can be used to 
monitor a host attached to a port, and if that host is removed (unplugged) then the port will be 
disconnected preventing another device being connected to the network at that point.  In addition, the 
switching action will cause a SwitchPortChange trap if this trap is supported by your switching system.  
This trap can be used to alert security personnel of the tamper event.  The affected port then has to be 
manually switched back on (either physically or through SwitchCenter). 
 

 
Figure 4 - IP Monitor Window 

 
To add a monitored IP address, enter the Port and IP address at the top of the page, and then click Add.  
An existing IP monitor entry can be temporarily disabled by selecting the entry and clicking 
Enable/Disable.  Similarly an entry can be removed by selecting and clicking Delete. 
 
The Port/Address Mapping area shows the current list of mappings, and their status.  The Last Action 
display area logs state changes (hosts becoming present/not present).  Note that port/address mappings are 
saved by the File Save operations while the last action log is not. 
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8. Scheduled tab 
 
The scheduled events page of SwitchCenter allows setting a point in time to cause a switching action.  
This action can be set up to 7 days in advance.  Repeating switching actions are also possible, with 
individual selection of day of week. 
 

 
Figure 5 - Scheduled Events Window 

 
To add a scheduled event, click Add….  This opens a window allowing the entry of port, rack, or system, 
position (A or B), time, day(s) of week, and one time/repeat.  After setting desired parameters, click OK 
to enter the scheduled event into the list.  An entry can be removed by selecting and clicking Delete. 
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Figure 6 - Add Scheduled Event Window 

 
The Scheduled Events display area shows all pending scheduled events and their status.  After one time 
events occur they are automatically removed from the list.  Repeating events will remain active on the 
scheduled events list indefinitely, or until removed. 
 
The Last Action display area logs scheduled events (one time or repeating).  Note that scheduled events 
are saved by the File Save operations while the last action log is not. 
 
 
9. Site Settings…  button 
 
To access the Site Settings, navigate to the Switch Control tab of the main application window and click 
the button labeled Site Settings….  This will open a window to allow entering of all the information 
pertinent to your site.  There are three tabs, labeled General, Display, and Advanced. 
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Figure 7 - Site Setup, General tab 

 
General tab 

IPAddress/FQDN: 
 
Enter an IP address in the form of X.X.X.X, or a fully qualified domain name like 
www.secureswitch.com.  This is the address of your switching system.  On the switching system, 
you will have to configure this address through the console initially. 
 
Read Password: 
 
This is the read community name for SNMP access as set through the console of the switching 
system.  The initial default for this is “public”.  Note that capitalization is important with this 
setting and must match the switch system setting exactly. 
 
Write Password: 
 
This is the write community name for SNMP access as set through the console of the switching 
system.  The initial default for this is “private”.  Note that capitalization is important with this 
setting and must match the switch system setting exactly. 
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Switch Model: 
 
Select the switching system model from the drop-down list.  This setting must match your 
switching system in order for SwitchCenter to function properly. 
 
Admin Password: 
 
Leaving this field blank allows full access to SwitchCenter.  If you enter a password here, when 
this site setup is loaded from the File Open menu (or as a command line specified configuration 
profile filename), a user will need to enter the password to gain access to all but monitoring 
functions. 

 

Figure 8 - Site Setup, Display tab 

 
Display tab 

Number of Racks: 
 
Set to the highest rack number in your system.  SwitchCenter supports up to 255 racks in one 
system, using rack numbers 1 through 255. 
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State Display Color: 
 
You can set the switch port panel color in the switch port control area (bottom) of the Switch 
Control tab for the switch state A and B buttons to make it easier to identify which switch state 
any port is currently set to.  Click either the "A State Color..." or the "B State Color ..." button, 
then use one of the optional methods to select a color to display.  Click OK to select the new 
color, and be sure to click OK when closing the Site Setup window. 
 
 

 
 

Figure 9 - Site Setup, Advanced tab 

 
Advanced tab 

Timeout in milliseconds: 
 
This is the amount of time to wait for SNMP commands to respond before timing out.  If your 
switching system is connected directly to the same subnet as your computer, this can be set 
relatively low (200-500).  However, if your system is located across a WAN or through other 
potentially time consuming links, then you should set this to a higher value (1000-6000).  Setting 
this too low risks missing packets that otherwise actually do complete, while setting too high 
makes SwitchCenter take a long time to refresh information if communication is actually 
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interrupted to your switch system.  A good initial setting is on the order of 2X to 3X the average 
round trip return time reported by an echo utility like PING.  See your operating system 
documentation to determine the appropriate way to invoke PING on your system. 
 
The R5000 and R6000 SNMP interface board may wait for up to 3 seconds for a response from 
the system.  If you are receiving “no response” or “skipped” for items you know are present, try 
increasing the SwitchCenter timeout to 3500 or 4000 milliseconds. 
 
SNMP Retries: 
 
SwitchCenter will retry a failed SNMP operation this many times before reporting an error or 
timeout.  SNMP uses the low priority UDP message service of IP, and therefore is subject to 
packet loss.  Set this to at least 3 to recover from packets dropped from the network. 
 
Skip status fields on timeout or error: 
 
Selecting this checkbox tells SwitchCenter to skip remaining status commands during a refresh or 
update when a timeout occurs.  This prevents long update delays when the site is inaccessible for 
some reason.  Fields will display “no response” or “skipped” as appropriate in the event of a fatal 
timeout condition (no response for all retries). 
 
Use switch names: 
 
Selecting this checkbox tells SwitchCenter to retrieve and display switch port names in the 
individual switch port control area (bottom) of the Switch Control tab.  This provides a way to 
label the switches for ease of control, however on slow networks (or across WAN links) this may 
cause unacceptable delays when switching racks or refreshing switch names. 
 
Automatic refresh time in seconds: 
 
This checkbox and text field control automatic refresh of status and switch information on the 
main switch control page of SwitchCenter.  Enable the checkbox and enter an update interval in 
seconds to use this feature. 
 
Display traps only from this IP address: 
 
Select this checkbox to filter incoming traps to only display those from the target switching 
system site address.  Otherwise, SwitchCenter will display all traps received (including any 
broadcast traps sent by some routers). 
 
Update system/rack status on trap: 
 
Selecting this option causes SwitchCenter to refresh system and rack status when any trap is 
received. 
 
Update switch position status on trap: 
 
Selecting this option causes SwitchCenter to refresh switch position status when any trap is 
received. 
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IP Monitor Retries: 
 
SwitchCenter will retry a failed echo command this many times before initiating the switching 
action associated with that entry.  This is to allow occasional packet loss without tripping 
unnecessarily. Typically this is set to at least 2, but it can be set as high as desired depending on 
the response your application needs. 
 
Command string: 
 
Use these fields to set the echo command string required by your operating system to detect the 
presence/absence of a host.  The command is constructed by using the first field, followed by the 
IP address or FQDN, followed by the second field.  This allows control of any parameters you 
may require in the command line.  This command string is passed to the underlying operating 
system for execution.  The default values provided are for all versions of the Windows operating 
system. 
 
Host present response starts with: 
 
Use this field to indicate the beginning of a successful echo command response.  The absence of 
this starting string in all lines of the entire echo response indicates a host not present. The default 
value provided is for all versions of the Windows operating system. 

 
 
10. SNMP 
 
SwitchCenter uses the SNMP protocol to communicate with the target switch system.  It is not necessary 
to understand SNMP to use SwitchCenter, however, if you will be also accessing the system through 
SNMP (an SNMP manager residing on a machine elsewhere on your network for example), then you 
should be aware that manipulation of the system with SwitchCenter will affect the associated SNMP 
variables.  Refer to the documentation for your particular R1000, R5000, R6000, or D1000 switching 
system to see which MIB and SNMP variables are applicable to your product. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


